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SOFTWARE LICENSE AGREEMENT

1. NOTICE.   Inscriber Technology Corporation IS WILLING TO LICENSE THE ENCLOSED SOFTWARE TO YOU ONLY ON THE CONDITION THAT YOU 
ACCEPT ALL OF THE TERMS CONTAINED IN THIS LICENSE AGREEMENT. PLEASE READ THIS LICENSE AGREEMENT CAREFULLY BEFORE OPENING 
THE SEALED DISK PACKAGE. BY OPENING THIS PACKAGE YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT 
AGREE TO THESE TERMS WE ARE UNWILLING TO LICENSE THE SOFTWARE TO YOU, AND YOU SHOULD NOT OPEN THE DISK PACKAGE. IN SUCH 
CASE, PROMPTLY RETURN THE UNOPENED DISK PACKAGE AND ALL OTHER MATERIAL IN THIS PACKAGE ALONG WITH PROOF OF PAYMENT, TO 
THE AUTHORIZED DEALER FROM WHOM YOU OBTAINED IT FOR A FULL REFUND OF THE PRICE YOU PAID.
2. Ownership and License. This is a license agreement and NOT an agreement for sale. We continue to own the copy of the software contained in this package and 
any other copy that you are authorized by this Agreement to make (the “Software”). Your rights to use the Software are specified in this Agreement, and we retain all 
rights not expressly granted to you in this Agreement. Nothing in this Agreement constitutes a waiver of our rights under any copyright law or any other law.
3. Permitted Uses.
3.01 Right to Install and Use. You may install and use the Software on the hard disk drive of any single compatible computer that you own. However, you may not 
under any circumstances have the Software installed onto the hard drives of more than one computer at the same time, nor may you install the Software onto the hard 
disk drive of one computer and then use the original distribution media on another computer. If you wish to use the Software on more than one computer, you must 
either erase the Software from the first hard drive before you install it onto a second hard drive, or else license an additional copy of the Software for each additional 
computer on which you want to use it.
3.02  Right to Copy. You may make one (1) copy of the Software for backup and archival purposes, provided that the original and the copy are kept in your possession, 
and that your installation and use of the Software does not exceed that allowed in Section 3.01, and provided you reproduce our copyright notice on the copy.
3.03 Right to Transfer. You shall not assign, transfer sublicense, rent, lend, or lease the Software or your rights under this Agreement without our prior written 
approval.
4. Prohibited Uses. You may not, without written permission from us: (a) use, copy, modify, merge, or transfer copies of the Software or documentation except as 
provided in this Agreement; (b) use any backup or archival copy of the Software (or allow someone else to use such copy) for any purpose other than to replace the 
original copy in the event it is destroyed or becomes defective; or (c) disassemble, decompile or “unlock,” reverse translate, or in any manner decode the Software or 
the dongle security device for any reason.
5. Limited Warranty. We make the following limited warranties from the date you acquired the Software from us or our authorized dealer:
(a) Media. For a period of twenty (20) days, the distribution media and documentation in this package will be free from defects in materials and workmanship under 

normal use. If the distribution media or documentation fail to conform to this warranty, you may, as your sole and exclusive remedy, obtain a replacement free of 
charge if you return the defective disk or documentation to us with a dated proof of purchase.

(b) Interlock Security Device. Provided you are in compliance with this Agreement, we will replace a damaged or defective interlock security device (dongle) no 
matter what the cause of the damage. In order to receive a replacement device, you must return the damaged device to Inscriber Technology Corporation, 
26 Peppler Street, Waterloo, Ontario, Canada N2J 3C4.

(c) WARRANTY DISCLAIMER. EXCEPT AS PROVIDED ABOVE, THE SOFTWARE AND DOCUMENTATION ARE PROVIDED ON AN “AS IS” BASIS, AND 
WE DO NOT WARRANT THAT THE SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT ITS OPERATION WILL BE UNINTERRUPTED OR 
ERROR-FREE. WE EXCLUDE AND EXPRESSLY DISCLAIM ALL EXPRESS AND IMPLIED WARRANTIES AND CONDITIONS NOT STATED HEREIN, 
INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Some jurisdictions do not allow the exclusion of implied warranties, so the above exclusion may not apply to you. This limited warranty gives you specific 
legal rights, and you may also have other legal rights, which vary from jurisdiction to jurisdiction.
6. LIMITATION OF LIABILITY. IN NO EVENT SHALL WE BE LIABLE FOR ANY INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES, 
INCLUDING BUT NOT LIMITED TO LOSS OF PROFITS, REVENUE, DATA, OR DATA USE, OR MACHINE USE, INCURRED BY YOU OR ANY THIRD 
PARTY, WHETHER IN AN ACTION IN CONTRACT OR TORT, EVEN IF WE HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. OUR 
LIABILITY TO YOU FOR ANY LOSSES SHALL NOT EXCEED THE GREATER OF $500 AND THE AMOUNT YOU ORIGINALLY PAID FOR THE 
SOFTWARE. 
Some jurisdictions do not allow these limitations or exclusions, so they may not apply to you.
7. United States Government Restricted Rights. The enclosed Software and documentation are provided with Restricted Rights. Use, duplication or disclosure by 
the U.S. Government or any agency or instrumentality thereof is subject to restrictions as set forth in subdivision (c)(1 )(ii) of the Rights in Technical Data and 
Computer Software clause at 48 C. F.R. 252.227-7013, or in subdivision (c)(1) and (2) of the Commercial Computer Software -- Restricted Rights Clause at 48 C.F.R. 
52.227-19, as applicable. Contractor Manufacturer is Inscriber Technology Corporation, 26 Peppler Street, Waterloo, Ontario, Canada N2J 3C4.
8. Termination. This license and your right to use this Software automatically terminate if you fail to comply with any provisions of this Agreement, destroy the copies 
of the Software in your possession, or voluntarily return the Software to us. Upon termination you will destroy all copies of the Software and documentation. Otherwise, 
the restrictions on your rights to use the Software will expire upon expiration of the copyright to the Software.
9. Miscellaneous Provisions. This Agreement will be governed by and construed in accordance with the laws of the Province of Ontario and not by the 1980 United 
Nations Convention on Contracts for the International Sale of Goods, as amended. This is the entire agreement between us relating to the contents of this package, and 
supersedes any prior purchase order, communications, advertising or representations concerning the contents of this package. No change or modification of this 
Agreement will be valid unless it is in writing, and is signed by us.
10. Quebec Transactions. If you reside in the Province of Quebec, Canada, you agree to the following: The parties hereto have expressly required that the present 
Agreement and its Exhibits be drawn up in the English language. Les parties aux presentes ont expressement exige que la presente convention et ses Annexes soient 
redigees en langue anglaise.

If you have any questions about this Agreement, write to us at Inscriber Technology Corporation, 26 Peppler Street, Waterloo, Ontario, Canada N2J 3C4, 
or call us at 519-570-9111.
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Introducing TitleMotion
Inscriber® TitleMotion™ is a professional graphics plug-in for creating high-end video titles and 
motion effects quickly. TitleMotion offers extensive control of all design and output aspects, and all 
TitleMotion graphics include full key channel support.

TitleMotion’s motion effects let you create multi-layered animations to fly any object around the 
screen using customized motion paths. All objects can be flipped, twisted, skewed, rotated, or moved 
individually in virtual 3D space, and each object can have independent acceleration and deceleration. 
You can also apply filters to animated objects over time.

Rendering time for motion effects is fast and animations are set up in keyframe mode, so you can 
preview animations in realtime using your NLE.

TitleMotion 
Overview

Using TitleMotion consists of 4 basic steps.

1 Open TitleMotion from within your NLE.

2 Create a title.

3 Add motion effects to the title.

4 Return to your NLE to render the title or animation.

Your
NLE

Your
NLEopen TitleMotion

from inside your
NLE

3

add motion
effects

4

return to your
NLE to use your
title or animation

create a
title

2

1
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Learn About TitleMotion
TitleMotion 
Modules

TitleMotion consists of three modules: CG, Logo Compose, and FX.

• CG lets you create still, rolls, and crawls, based on blank templates or 
fully laid out templates. You also use CG to create the initial title for an 
animation.

• Logo Compose lets you clean up and add alpha to any image, and then 
use that image in CG.

• FX lets you add animations to any title created in CG.
• The Scrapbook is a TitleMotion feature that lets you transfer images, 

titles, and styles between titles and between TitleMotion modules.

About this 
Document

This document is designed to get you up and running with TitleMotion as 
quickly as possible. It won’t teach you everything about TitleMotion, but it 
introduces you to all the major features available in TitleMotion. By the 
time you’ve looked through this document, you should be able to handle all 
of the basic TitleMotion tasks. From there, you can go to the online help 
for more detailed information about specific options.

Online Help The online help system is designed to give you all of the information you 
need about every feature available in TitleMotion. If you need more details 
than this document provides, check the online help. You can open the 
online help by selecting Help�Help Topics from the menu bar.

The online help is arranged by module. It also covers all of the TitleMotion 
preferences and includes a complete glossary.

The TitleMotion 
Screen

Tools or
Formatting
palette

Formatting
sample
(in CG
only)

Scrapbook
Attributes

tabs

Editor
window

Status
bar

module
toolbarmain

toolbar
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Did you know...
This section explains some global features of TitleMotion that speed up your work. TitleMotion 
provides additional methods for entering numbers in fields, switching between certain options and 
dialogs, and getting to useful tools.

Change Field 
Numbers—Fast

TitleMotion provides several ways to set the numbers in fields.

1 You can type a number directly into a field.

2 You can click on the up and down arrows beside the field.

3 You can use the Inscriber scroll option. Place the pointer over the 
field, hold down the left mouse button, and drag up or down to 
increase or decrease the field number.

The Inscriber scroll option is usually a faster way to change field 
numbers than any of the standard Windows methods.

4 You can reset a field number to the default by double-clicking on the 
field.

type a number
into a field

1

click on the 
up and down 
arrows

2

click in the field and
drag your mouse up
or down

3

double-click to
return the field
number to the default

4
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Change Layers in 
CG

Each CG title has 10 layers, and each layer is divided into a text plane and 
a graphics plane. You can see what text and graphics are located on each 
layer by selecting Element�Layer Control�Layer List to display the Layer 
List dialog.

The text plane of each layer is always on top of the graphics plane. If you 
want a graphic object on top of text, you need to put it on the layer above 
the text.

You can move text and graphic objects among CG layers using the mouse 
and control keys.

1 Hold down the CTRL and SHIFT keys on your keyboard.

2 Click on the object you want to move and drag the pointer up or down.

The number on the pointer identifies the layer the object is moving to. 
Moving the pointer up increases the layer number. Moving the pointer 
down decreases the layer number.

3 Release the left mouse button when the pointer displays the number of 
the layer you want to move the text or graphic object to.

you can see what
layer an object is on

by looking at the
status line at the

bottom of the
TitleMotion window

You can also change the layer that a line of text or a graphic object is on by 
selecting the text or object, holding down the CTRL and SHIFT keys, and 
pressing the up or down arrow keys. You can see what layer an object is on 
by looking at the status line across the bottom of the TitleMotion window.

Shift

Ctrl

'

→

→

→ →

1

hold down the
CTRL and SHIFT

keys

2click on an object
and drag the pointer

up or down

release the mouse
button when the
layer number is right

3
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Cycle Buttons TitleMotion uses cycle buttons to let you access more settings on the 
Attributes tabs. You can identify a cycle button by the large arrowhead in 
the top corner of the button.

Left-clicking on a cycle button moves you forward to another set of options. 
Right-clicking on a cycle button moves you backwards through the set of 
cycle button options. The following graphic shows you the options 
accessed by the cycle button on the Color & Texture tab.

1 Left- or right-click on a cycle button to move to another set of options.

You may have to click on the cycle button more than once to get back 
to the original set of options.

Color Chips You can click on face, edge, and shadow color chips to access particular 
cycle buttons more quickly than clicking on the cycle button itself.

1

click on the 
cycle button to
move through the various options

face color chip

edge color chip

shadow color chip
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Enter Special 
Characters

Each font set contains more characters than you can see on your keyboard. 
Some common special characters include copyright and trademark symbols 
(©, ™), fractions (¼, ½, ¾), and accented characters (É, è, ü).

Using the Mouse

1 Make sure that you are on the text plane of the current CG layer.

2 Select a font from the Fonts drop-down list on the Size & Attributes 
tab.

3 Select Edit�Character Map.

4 Click on the character that you want to add to your text line.

5 Use the Backspace button to erase any characters that are incorrect.

6 When you have finished entering characters on your text line, click on 
OK to accept the characters and return to your CG title.

If you do not want to keep the characters you entered using the 
Character Map, you can click on Cancel to return to your CG title 
without entering any new characters.

click on OK to finish,
or click on Cancel to 

delete any changes

6

click on
characters to
add them to

your text line

4

click on Backspace
to delete characters

5

make sure the text
plane is selected

1

select a font 2

select Edit    Character Map3 →
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Using the Keyboard
You can use the keycodes displayed in the character map to enter special 
characters using the keyboard, if you don’t want to display the character 
map every time you need to add a special character.

1 On the Character Map, place your pointer on top of the character you 
want to enter.

2 Write down or remember the number displayed in the ToolTip.

3 Close the Character Map.

4 Hold down the ALT key and enter the number from the Character Map 
using the number pad. Then release the ALT key.

You can only enter the number using the number pad keys.

Right-Click Menus Right-click menus provide you with a quick way of accessing certain 
common options and commands. Right-click menus occur in these places:

• CG workspace
• CG style chips
• FX workspace
• FX Attributes tabs
• FX Tool palette
• Logo Compose workspace
• Logo Compose tools
• Scrapbook

1 Right-click on one of these areas to display the right-click menu.

2 Use the mouse to select one of the commands from the right-click 
menu. You can close the right-click menu by clicking anywhere else on 
the workspace.

1 right-click to display
the right-click menu

use the mouse to
select a menu
item from the
right-click menu

2
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TitleMotion Basics
Working with 
NLEs

TitleMotion acts as a plug-in for your NLE, and since each NLE works a 
little differently with TitleMotion, Inscriber has created a series of release 
notes that describe each NLE individually. These release notes are available 
on our website, at www.inscriber.com.

In general, you open TitleMotion from within your NLE, create and save 
your titles, close TitleMotion, and return to your NLE, where you can open 
your titles from the NLE’s bin or library.

Create a Title This section explains the fastest way to create a title in TitleMotion. You 
can find more details about creating titles starting on page 16.

1 Select template 1123 Lower Third 23 from the Templates drop-down 
list.

2 Double-click on the word Heading to select it.

3 Enter new text in the text line.

3
enter

new text

2

double-
click on

the word
Heading

1

select a
template
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Save a Title You can save a title by selecting File�Save.

When you save a file in TitleMotion, it is dropped in a bin or library, or 
otherwise located where your NLE expects to find CG files and animations.

If TitleMotion doesn’t plug directly into your NLE, or you are working in 
stand-alone mode, you can use the File�Export options to export titles 
and animations as a series of Targa files that your NLE can import and 
combine. The online help explains how to export titles in detail.

Open a Title You can open a title by selecting File�Open.

When you open a title, TitleMotion displays a standard Windows dialog 
that lets you navigate to and select your .ins file.

If you want to open a title that is not in .ins format, you can use the 
File�Import options to open .cgr, .icg, .sly, or .txt files.



10 TitleMotion

Sc
ra

pb
oo

k

The Scrapbook
The Scrapbook is used to transfer titles, backgrounds, logos, textures, and style chips between titles, 
and between modules in TitleMotion. Each module uses the Scrapbook a bit differently. Any items in 
the Scrapbook are saved each time you close TitleMotion. When you open TitleMotion again, your 
Scrapbook items are still available.

Scrapbook 
Conventions

When you first open TitleMotion, the Scrapbook is empty and the Inscriber 
logo above the word Scrapbook is visible.

The item that is visible in the Scrapbook is the selected item. When you 
add an item to the Scrapbook, the new item appears in the Scrapbook and 
becomes the selected item. You can use the scroll bar below the Scrapbook 
to select a different item. The scroll bar only appears when you have 
something in the Scrapbook.

The Scrapbook right-click menu changes depending on what module you 
are in. In Logo Compose, the Use item in the Scrapbook menu is always the 
same, but in CG, the Use item in the Scrapbook menu changes depending 
on the selected item. If the item can only be used for one purpose, only the 
Use item appears, but if you can use the item for several purposes, a list of 
possible Use items appears instead.

Scrapbook Right-Click Menus

standard menu

additional CG
module menu
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The Right-Click 
Menu Options

This table describes the Scrapbook right-click menu options.

Menu Option Result

Add • copies an item into the Scrapbook

Use • uses the selected Scrapbook item
• appears if the item has only one possible Use 

option

Use Background • in CG, copies the selected item to the 
background layer of the title, and replaces any 
existing background

Use Texture • in CG, copies the selected item to the Texture 
map

Use Layout/Title • in CG, replaces the current title with the selected 
item

Use Logo • in CG, copies the selected item to the Logo map

Delete • removes the selected item from the Scrapbook

Clear All • removes all items from the Scrapbook

Copy to 
Clipboard

• copies the selected Scrapbook item to the 
Windows clipboard

Paste from 
Clipboard

• adds an item from the Windows clipboard to the 
Scrapbook

Info • opens a dialog that tells you how many items are 
in the Scrapbook and how much disk space 
Scrapbook is using
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The Scrapbook and CG
Add Items to the 
Scrapbook

You can add style chips and titles to the Scrapbook using the right-click 
menu. You can also drag and drop style chips into the Scrapbook.

1 Create a title or select one of the default templates in CG.

2 Right-click on the Scrapbook.

3 Select Add from the Scrapbook right-click menu to add the title to the 
Scrapbook.

4 Switch to the Styles tab by clicking on the tab name.

5 Click on a style chip.

6 Select Add from the Scrapbook right-click menu.

7 Click on another style chip and drag it to the Scrapbook.

8 Use the scroll bar to scroll through the items in the Scrapbook.

4 click on
the Styles
tab

3 select Add
from the right-
click menu

create or
open a title
in CG

1

right-click
on the
Scrapbook

2

drag a style
chip to the
Scrapbook

use the scroll
bar to scroll
through items

select Add from
the right-click menu

click on a
style chip

7

8

65
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Scrapbook

Use Items in the 
Scrapbook

1 Use the scroll bar to select an item in the Scrapbook.

2 Select one of the Use options from the Scrapbook right-click menu.

The Use options are described in the table on page 11.

Delete Items in 
the Scrapbook

You can remove single items from the Scrapbook, or remove all items in the 
Scrapbook.

1 Right-click on the Scrapbook.

2 Select Delete to remove the selected item from the Scrapbook.

3 Select Clear All to remove all items from the Scrapbook.

4 Click on Yes to confirm that you want to remove all items from the 
Scrapbook.

You cannot recover items deleted from the Scrapbook.

1 use the scroll bar
to select an item

2 select a Use
option from the
right-click menu

1right-click on
the Scrapbook

2select Delete
to remove

an item

3select Clear All
to remove

all items
4 click on Yes

to remove
all items
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The Scrapbook and Other Modules
The Scrapbook 
and the Clipboard

You can copy images from the Scrapbook to the Windows Clipboard, and 
from the Windows Clipboard to the Scrapbook. This feature lets you copy 
images from a third-party package to the Clipboard and then import the 
image into the Scrapbook so that you can use it in any TitleMotion module.

1 Copy an image to the Clipboard from a third-party package.

Any copy operation uses the Clipboard to hold the copied image.

2 Open TitleMotion.

3 Select Paste from Clipboard from the Scrapbook right-click menu.

4 Switch to the TitleMotion module you want to use the image in.

5 Select one of the Use... options from the Scrapbook right-click menu.

You can also drag and drop any bitmap file into the Scrapbook from the 
desktop or a Windows application like Explorer using standard Windows 
drag-and-drop techniques.

Third-party
Package 1 copy an image

to the Clipboard

open TitleMotion

select Paste
from
Clipboard

select one of
the Use options

switch to the
module you want
to use the image in

2

3 4 5
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The Scrapbook 
and Logo 
Compose

In Logo Compose, you can add images to the Scrapbook, and add 
Scrapbook items to Logo Compose images. Any Logo Compose image 
added to the Scrapbook is labelled as a background.

Add Logo Compose Images to the Scrapbook.

1 In Logo Compose, open one of the images in the Samples folder, 
located in your TitleMotion folder.

2 Right-click on the Scrapbook.

3 Select Add from the right-click menu.

Add Scrapbook Items to Logo Compose Images.

1 Use the scroll bar to select a title or a background in the Scrapbook.

You can’t use style chips in Logo Compose.

2 Select Use from the right-click menu.

When you add a Scrapbook item to a Logo Compose image, the image 
size is not changed. You may have to increase your canvas size if the 
item is too big, or crop your canvas if the item is too small.

The Scrapbook 
and FX

The Scrapbook is not used with FX.

3 select
Add

create or open an
image in Logo Compose

1

right-click on
the Scrapbook

2

2 select Use
from the
right-click
menu

1

use the
scrollbar

to select a
title or a

background
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Template Manager
The Template Manager collects and organizes title templates. TitleMotion comes with over 150 
Inscriber templates, but you can also use the Template Manager to add and organize your own 
templates.

What are 
Templates?

Templates define titles in CG. All titles are based on templates. Your title is 
based on the default template, unless you select a different template. 
Templates define the initial settings of your title. Text styles, graphic styles, 
and logos are included in templates so that titles based on the same 
template can use the same logos and styles.

Some templates are extremely simple, and others are more complex. You 
can check out some of the Inscriber templates to get a better idea of what a 
template is.

1 Click on the Templates drop-down list.

2 Select template 1130 Lower Third from the list.

As you move your pointer over each of the templates in the list, a 
thumbnail of the title is shown to the right of the list. The thumbnails 
make it easier to find titles in the list.

Why Use the 
Template 
Manager?

The Template Manager makes your templates accessible from the 
Templates drop-down list on the TitleMotion toolbar. You can also see a 
thumbnail of each template as you scroll down the list. The Template 
Manager provides a quick and easy way to organize and find titles in 
TitleMotion.

Open and Close 
the Template 
Manager

You can open the Template Manager in three ways:

• select File�Template Manager...
• select Open Template Manager from the CG right-click menu
• press CTRL+SHIFT+R

The six buttons on the dialog provide all of the tools you need to manage 
your templates.

1 click on the
drop-down
list

2
select template
1130 Lower Third
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Tem
platesYou can close the Template Manager in two ways:

• click on Close
• press ESC

Load a Template You can load a template as the current CG title.

1 Open the Template Manager.

2 Select a template to load.

3 Click on the Load Template button, or double-click on a template 
name.

The Template Manager loads the template into CG as the current title 
and closes the Template Manager.

Add a Template You can add the current CG title to the Template Manager as a template.

1 Create a title in CG.

2 Open the Template Manager.

3 Click on the Add button.

tools to
manage your
templates

1 open the Template
Manager

2 select a
template

3 click on
Load Template
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4 Enter a number for the template.

Templates are sorted by number. All of the Inscriber templates have 
numbers greater than 1000, and are grouped according to type. You 
can do the same sort of numerical grouping with your own templates.

5 Enter a name for the template.

6 Click on OK and then close the Template Manager.

Update a Template You can update a selected template with the current CG title.

1 Open an existing template in CG and make a change.

2 Open the Template Manager.

3 Select a template to update.

4 Click on the Update button.

5 Click on Yes to replace the selected template with the CG title, and 
then close the Template Manager.

1 create a title
in CG

2 open the
Template Manager

3 click on the
Add button

4 enter a number
for the template

6 click on OK5 enter a name
for the template

1 open and change
a template

2 open the Template
Manager

5 click
on Yes

3 select a
template

click on
Update4
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plates

Rename a 
Template

You can rename a template and give it a new number.

1 Open the Template Manager.

2 Select a template to rename.

3 Click on the Rename button.

4 Enter a new name or number for the template.

5 Click on OK and then close the Template Manager.

Delete a Template You can delete a template from the Template Manager.

1 Open the Template Manager.

2 Select a template to delete.

3 Click on the Delete button.

4 Click on Yes to delete the template.

The Default 
Template

The default template is always numbered zero (0) and is always called 
“default template”. You can change the default template by updating it with 
the current CG title, but you cannot rename or delete it.

The default template is used whenever you open TitleMotion or create a 
new title. All titles are based on a template, and usually the default 
template is a simple, blank template. However, if you need certain text or 
graphic elements on every title you create, you can add them to the default 
template by creating a title with the necessary elements and then updating 
the default template.

open the
Template
Manager

3click on
Delete

2 select a
template

4

click on
Yes to delete
the template

1
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Styles
What are Styles? Styles define a set of attributes for text in CG, such as height, color, edge 

size, and shadow settings. All text is based on a style. If you don’t select a 
style, your text is formatted using the default text style for the title.

When you apply a style to a text line, the text line is connected to the style. 
When you make a change to the attributes of a text line, any other text 
formatted with the same style is also changed.

All styles are identified by number. You can see all 24 styles on the Styles 
tab. The number of each style is located in the bottom right corner. The 
first eight styles are also visible on the Formatting palette.

Some text styles are extremely simple, and others are more complex. You 
can look at some of the Inscriber styles when you open the Style Library.

Text styles save size, attributes, and color information, but they do not save 
texture information. If you want to use textures, you need to add the texture 
after you apply the text style.

What are Style 
Chips?

The 24 styles available in each template are stored in style chips on the 
Styles tab. Each style chip contains a unique style that can be applied to 
text lines in a CG title. You can apply a new style to text by clicking on the 
style chip.

When you place your pointer over a text style, the ToolTip shows you a 
number and the font used in the style. The number is the total height of the 
font in scanlines, and gives you an idea of how big the text is.

Styles tab

style
chip

Style ToolTip
(height and font)
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Style Library

Style Chip Right-
Click Menu

You can right-click on style chips on the Styles tab or on the Formatting 
palette to display the right-click menu.

The Style Library options on the right-click menu are explained on the next 
few pages. The other right-click menu items are explained in the online 
help.

Apply a Style 1 Select some text by either clicking on a text line or highlighting 
characters within a text line.

2 Switch to the Styles tab.

3 Click on a style chip.

Create a Style Since all styles in TitleMotion are based on a style chip, you never actually 
create a style. Instead, you apply a style to text and then use the options on 
the Attributes tabs to modify the style.

style chip
right-click
menu

1

select
some text

2

switch to
the Styles

tab

3

click on
a style

chip
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Style Library
The Style Library collects and organizes text styles. TitleMotion comes with over 150 Inscriber text 
styles, but you can also use the Style Library to add and organize your own text styles.

Why Use the Style 
Library?

The Style Library makes your styles accessible to any title, and provides a 
quick and easy way to organize and find text styles in TitleMotion. The 
Style Library also lets you transfer text styles between titles without having 
to use the same template.

Open and Close 
the Style Library

You can open the Style Library by selecting Open Style Library from the 
style chip right-click menu. 

The six buttons on the dialog provide all of the tools you need to manage 
your styles.

You can close the Style Library in two ways:

• click on Close
• press ESC

Load a Style You can load a style into the selected style chip.

1 Select a style chip.

2 Open the Style Library.

3 Select a style to load.

4 Click on the Load Style button, or double-click on the style.

The Style Library loads the style into the selected style chip and closes 
the Style Library.

tools to
manage your
styles
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Style Library

Update a Style You can update a style in the library with the selected text style on your 
title.

1 Apply a style in CG and change some of the text attributes.

2 Open the Style Library.

3 Select a style to update.

4 Click on the Update button.

5 Click on Yes to replace the selected style with the current CG text 
style.

1 select a
style chip

open the
Style Library

2 select
a style

3 click on the
Load Style
button

4

1 create a
style in CG

3 select a
style

2 open the
Style Library

4 click on
the Update
button

5 click on Yes to
replace the style
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Add a Style You can add the current text style to the Style Library.

1 Apply a style in CG.

2 Select Add to Style Library from the style chip right-click menu.

You need to right-click on the style chip for the current style when you 
add a style to the Style Library. CG creates the new library entry using 
the settings of the style chip that you right-clicked on, not the settings 
of the selected text line.

3 Enter a number for the style.

Styles are sorted by number. All of the Inscriber styles have numbers 
greater than 100, and are grouped according to type. You can do the 
same sort of numerical grouping with your own styles.

4 Enter a name for the style.

5 Click on OK.

select Add to
Style Library

2

1 create a style
in CG

enter a number
for the style

3

click
on OK

5

enter a name
for the style

4
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Style Library

Rename a Style You can rename a style and give it a new number.

1 Open the Style Library.

2 Select a style to rename.

3 Click on the Rename button.

4 Enter a new name or number for the style.

5 Click on OK.

Delete a Style You can delete a style from the Style Library.

1 Open the Style Library.

2 Select a style to delete.

3 Click on the Delete button.

4 Click on Yes to delete the style.

1

2

3

open the
Style Library

select a style

click on the
Rename

button

4 enter a new
name or number

5click
on OK

2 3

1

4

open the
Style

Library

click on
Yes to delete

the style

select a
style

click on
Delete
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Enter Text To enter text, you need to be on the text plane and your text line must be 

selected. When you first open a new title, the text plane is usually selected 
and the cursor is flashing inside the white rectangle on the title. However, 
that may not always be the case, so the procedure below explains all of the 
necessary steps for entering text.

1 Click on the Text Plane button on the TitleMotion toolbar.

2 Click inside the white rectangle in your title.

3 Type a line of text.

Anchored and 
Floating Text

Anchored text is horizontally constrained to a tab. That means you can 
move the text up and down, but you can’t move it side to side.

Floating text can be moved anywhere on the title.

Anchored text appears between brackets and floating text appears in a 
white rectangle, so you can tell just by clicking on a line whether your text 
is anchored or floating.

use CTRL+TAB to
switch between

anchored and
floating text

You can switch between anchored and floating text easily.

1 Click on the text.

2 Press CTRL+TAB to switch between anchored and floating text.

1click on the text
plane button

click inside
the white
rectangle

type a line
of text

2

3

1 click on the text

Shift

Ctrl

Caps Lock

Tab

Shift

Ctrl

Caps Lock

Tab

press the CTRL+TAB
keys to switch
between anchored
and floating text

2
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Move Floating 
Text

1 Click on the text.

2 Position your pointer just above or below the middle of the text line, 
until the pointer has a small + to the right of the pointer arrow.

3 Drag the text line to a new position anywhere on the title.

you can hold down
CTRL and position

your pointer
anywhere above or
below the text line
to drag it to a new

position

Move Anchored 
Text

1 Click on the text.

2 Position your pointer just above or below the middle of the text line, 
until the pointer has a small + to the right of the pointer arrow.

3 Drag the text line to a new vertical position on the title.

Even if you drag your pointer to one side or the other, your text line 
does not move left or right, only up or down.

1 click on
the text

position your pointer
above or below the
middle of the text line

2 drag the text
line to a new
position

3

click on
the text

position your pointer
above or below the
middle of the text line

drag the text
line to a new
position

3

1

2
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Re-Wrap Text You can set your text to wrap automatically to the next line when you reach 

the edge of the video safe title area by selecting 
Element�Constrain�Word Wrap. If you then delete or modify your text, 
you can re-wrap it to eliminate gaps or odd line breaks.

1 Highlight the text that you want to re-wrap by clicking in the first text 
line and dragging the pointer over the text.

2 Select Element�Re-Wrap Selection, or select Re-Wrap selection from 
the CG right-click menu.

Only the highlighted text is re-wrapped.

Resize and Rotate 
Text

You can resize and rotate text using the mouse. The pointer changes its 
appearance depending on where you place it over a text line, and the 
various pointers allow you to resize and rotate your text. The following 
diagram shows you the different pointers and where they appear.

Remember that if you make your 
text too small, you may not be 
able to highlight it and modify 
the text style. You should 
probably set the text style before 
you resize your text.

select Element
    Re-Wrap
Selection 

1

→

2

highlight 
text

Pointer Description

Move Tool • moves the text to a new position

Resize Text Height 
and Width

• resizes the height and width of text

Resize Text Width • resizes the width of text 

Rotate Text • rotates text
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Spellcheck Titles Spellcheck features let you check the spelling of all text in a title or just the 
text on a single layer. You can determine the kinds of spelling errors 
Spellcheck looks for, and set up custom user dictionaries.

1 Type your text.

2 Select Element�Spellcheck�Title Page.

If Spellcheck finds an error, it displays the Suggestions dialog.

3 Correct the word by doing one of the following:

• click on Replace to use the word in the Suggestion field
• select another word from the Suggestion List and click on Replace
• type the correct word in the Suggestion field and click on Replace
• click on Ignore to leave the word uncorrected

4 Click on Quit Checking to finish your spellcheck.

Create and Modify 
Dictionaries

With the Suggestions dialog on the screen, you can also create and modify 
your dictionaries, as well as modify the Spellcheck options.

1 Click on Add to add the unknown word to your custom dictionary.

The Custom dictionary dialog is displayed, and you can use the dialog 
to add a word, delete a word, and enter a new filename for your custom 
dictionary.

2 Click on Add to add the unknown word to the default dictionary.

3 Click on Options to display the options Spellcheck uses to find words 
that are not spelled correctly.

Options that are checked are used by Spellcheck. Options that are not 
checked are ignored.

2

3 4

type your
text

select Element→
Spellcheck→
Title Page click on

Quit
Checking

click on
Replace to
correct the word

1
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Vertical Text Vertical text displays your text vertically, one character at a time, starting 

from the top right corner of your title and moving to the left side of your 
title.

Vertical text has some limitations:

• you can only use vertical text in still and roll titles
• in still titles, text automatically wraps to the top of the next line, but in 

roll titles, you must press ENTER to move to the top of the next line
• vertical text processing is only available on text layers 1 to 8, not 9 or 10

you can switch
between normal
text and vertical
text by pressing

ALT+V

1 Make sure you are on the text plane of a CG title.

2 Select Element�Layer Control�Vertical Text Processing.

3 Begin typing your text.

Text in a Box You can create text boxes that limit text to the width of the box. When you 
change the size of the box, the text is automatically re-wrapped to fit the 
new size.

1 Click on the Text Box tool.

2 Draw a text box on your title.

3 Enter your text in the text box.

4 Use the grab handles to resize your text box.

Text is automatically re-wrapped when you resize the text box. You can 
only adjust the width of your text box—the height is controlled 
automatically by the amount of text in the box.

1make sure you are
on the text plane

select Element→
Layer Control→
Vertical Text
Processing

2 type your text3
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Text in a box is placed on the graphics plane. To select text in a box, make 
sure you are on the graphics plane and then click on your text box.

Text on a Circle You can create circles for text to run around. When you change the size of 
the circle, the text is automatically redrawn to run around the new circle.

Text in a circle is placed on the graphics plane. To select text in a circle, 
make sure you are on the graphics plane and then click on your text circle.

1 Click on the Text Path tool.

2 Draw a rectangle on your title.

A path appears inside the rectangle.

3 Select Element�Constrain�Circle.

4 Enter your text around the circle.

5 Use the grab handles to resize the circle.

Text is automatically re-wrapped when you resize the circle.

1
click on
the Text
Box tool

3 enter your text
in the text box

4 use the grab handles
to resize the text box

2 draw a
text box

1click on the
Text Path tool

2

draw a
rectangle
on your title

use the grab handles
to resize the circle

5

enter your text
around the cirlce

4

3 select Element→Constrain→Circle
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Text on a Path You can create curved paths for text to run along. When you change the 

shape of the path, the text is automatically redrawn to run along the new 
path.

1 Click on the Text Path tool.

2 Draw a rectangle on your title.

The path appears inside the rectangle if your rectangle is large 
enough.

3 Enter your text on the path.

4 Use the control points to reshape your path.

Text is automatically re-wrapped when you reshape the path.

Text on a path is placed on the graphics plane. To select text on a path, 
make sure you are on the graphics plane and then click on your text path.

CTRL+SPACEBAR adds
control points on text

paths, CTRL+
BACKSPACE deletes

control points

You can add control points to a path by clicking on an existing control 
point and pressing CTRL+SPACEBAR. You can delete control points from a 
path by clicking on a control point and pressing CTRL+BACKSPACE. New 
control points always appear on top of the original control point. You need 
to click and drag the new control point to another position to see it.

You can also return your path to the original, default path by selecting 
Element�Constrain�Default Path.

1click on the
Text Path tool

2 draw a
rectangle

3 enter your
text on
the path

4 use the
control points
to reshape
your path
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Delete Boxes, 
Paths, and Circles

Text in a box, on a path, or on a circle use standard tools to edit text, like 
the arrow keys, the BACKSPACE key, and CTRL+X, CTRL+V, and CTRL+C 
combinations. Normally, you can use CTRL+X to delete a graphic object, 
but this key combination doesn’t work for text boxes, paths, or circles.

If you want to delete the entire box, path, or circle, use CTRL+DELETE. When 
you delete a box, path, or circle, the entire object and all the text in it is 
deleted. If you just want to edit the text in a box, path, or circle, you can 
click on it and use standard text editing tools.

delete circles, paths,
and boxes by

pressing CTRL+DELETE

When you delete a box, path, or circle, the object is deleted and you 
remain on the graphics plane. However, after you delete the object, nothing 
is selected, so you need to click on a graphic object or switch to the text 
plane to continue working on your title.

new control point

default path move control point

delete control point

CTRL+DELETE
deletes the entire

object and its text

standard editing tools
modify individual letters
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Formatting Text
You can modify the appearance of text in titles by using the Attributes tabs to change various settings.

Some Guidelines 
for Formatting 
Text

You can modify your text using the Size & Attributes and Color & Texture 
tabs. The best way to see what all of the settings do is to enter some text 
and then change each setting and see what happens. You can also apply a 
style from the Style Library and then look at the settings for that text style.

However, these guidelines can make formatting text easier.

highlight text
before changing it

to modify only a
portion of your text

• If you make changes on the Size & Attributes and Color & Texture tabs, 
all text that shares the same style is changed. If you only want to change 
some text, highlight the text that you want to change first.

• If you want to edit text, rotation (set on the Size & Attributes tab) must 
be 0. You should make sure your text is correct and then rotate it.

Change the Face 1 In CG, select the default template from the Templates drop-down list.

2 Enter a line of text in the CG title.

3 Highlight one word in your text line.

4 Change the selections on your Size & Attributes tab to match the 
following example:

5 Switch to the Color & Texture tab.

6 Click on the Face color sample until the word TOP appears. You should 
only have to click once.

1select the
default

template

2enter text

3highlight
a word

4 change the
Size & Attributes
tab settings

5 switch to the
Color & Texture tab
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7 Change the color values to H=0, L=30, S=100.

Change the Edge This procedure assumes that you are continuing on from Step 7, above.

1 Click on the Edge color chip.

2 Click on the Edge color sample until the word TOP appears.

3 Change the color values to H=0, L=96, S=100.

4 Change the Edging size to 2.

5 Change the Edge type to Outline.

6 Change the Angle to 29.

Change the 
Shadow

You can change the text shadow in the same way that you change the text 
edge.

6click on the Face
color sample

7change the H, L,
and S color values

5 select Outline

1click on the
Edge color chip

2 click on the Edge
color sample

4change the
Edge size

3 change the
H, L, and S
color values

change the angle 6



36 TitleMotion

Ex
te

nd
ed

 S
ty

le
s

Extended Text Styles
TitleMotion also offers a number of extended text styles. The Style Library contains many samples of 
extended text styles, but this section shows you how to create your own extended text style.

Types of Extended 
Styles

The extended text styles include these six types of styles:

Create an 
Extended Text 
Style

1 In CG, select the default template from the Templates drop-down list.

2 Enter a short word, like Next or Live, in the title.

3 Change the selections on your Size & Attributes tab to match the 
following example.

4 Change your Edge type to Sheen.

5 Switch to the Color & Texture tab.

embellished

recessed

10 edges

sheen
neon

edge over face

1select the
default

template

2enter text

3change the values
on your Size &

Attributes tab 4 change the
edge type
to Sheen

5 switch to the
Color & Texture
tab
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6 Change all four face colors to H=204, L=31, S=92.

You can change the face colors by clicking on each color sample and 
then changing the HLS numbers.

7 Change the Sheen color to H=60, L=89, S=26 by clicking on the 
Sheen color chip and then changing the HLS numbers.

8 Change the Size to 31, the Offset to -7, and the Angle to -26.

9 Click on the Face cycle button to change to the Edge & Sheen options.

select more than one
Face color sample by

using the selection
buttons

10 Change your Edge size, Size, and Angle numbers to match the 
following example.

11 Change the color of the bottom left edge to H=0, L=0, S=0.

12 Change the color of the other three edge colors to H=223, L=33, 
S=84.

click on the X
to select all four

Face color samples

click on a line
to select the two

Face color samples
on either side of

the line

change colors
by entering
new numbers

6 change the
face colors

7 change the
sheen color

8 change the size,
offset, and angle

9 cycle to the Edge
and Sheen options

10 change the
edge size, size,
and angle numbers

change the color of the 
bottom left edge

11

12 change the rest
of the edge colors
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Learn How to Use Styles
All text is associated with a style group. You can change the style group a line of text is associated 
with by clicking on a different style chip on the Styles tab.

A key point that you need to remember about styles is that all text formatted with the same style is 
changed when you adjust settings on the Size & Attributes and Color & Texture tabs. However, you 
can use highlighting to change only selected text. This section explains how to manage your text 
formatting, but you can also see the online help for more details on using styles to format text.

Change Multiple 
Text Lines

Style groups let you format multiple lines of text at the same time.

1 In CG, select the default template from the Templates drop-down list.

2 Switch to the Styles tab.

3 Click on Style 15.

4 Enter three or four lines of text in the title.

5 Switch to the Color & Texture tab.

6 Click on the Shadow color chip.

7 Change the shadow color to H=0, L=31, S=100.

All of the text in your title changes when you adjust a setting on the 
Color & Texture or Size & Attributes tabs.

1select the
default

template

4enter
some text

5switch to the
Color &

Texture tab

2switch to the
Styles tab

3 click on
Style 15
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Change Single 
Lines or 
Characters

Once you have selected a base style, you can use highlighting to change 
only a portion of the text. You can highlight a single letter, a few letters, an 
entire line, or several lines at once.

1 In CG, select the default template from the Templates drop-down list.

2 Enter the names of three cities in the title. Make sure that each city 
name starts with a capital letter.

3 Highlight a portion of the text by clicking in a text line and dragging 
the cursor to select text.

6 click on the Shadow
color chip

7 change the
shadow color

7look at the Formatting sample

6change the face color

3highlight
some text

1select the
default

template

2enter some
city names

4switch to the
Color &

Texture tab

5click on the
Face color

chip
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4 Switch to the Color & Texture tab.

5 Click on the Face color chip.

6 Change the face color to H=157, L=69, S=99.

7 Look at the Formatting sample on the Toolbar palette.

The + sign indicates that the highlighted text won’t be affected if you 
make changes to the style.

8 Click on another text line to remove the highlight.

9 Click on the Face color sample until the word BOTTOM appears on the 
chip.

10 Change the bottom face color to H=238, L=80, S=84.

The style chip and the text that you didn’t highlight are changed, but 
the text that you highlighted and changed remains the same.

11 Switch to the Styles tab.

12 Highlight the capital letter of the first city name.

13 Click on Style 15.

14 Highlight the capital letter of the second name and click on Style 15.

change
the bottom
face color

10

8 click on
another
text line

9click on the Face
color sample until

Bottom appears

11 switch to
the Styles
tab



TitleMotion 41

Extended Styles

15 Highlight the capital letter of the third name and click on Style 15.

16 Place your cursor at the start of one of the city names.

Your format sample should have a 15 in the bottom right corner.

17 Switch to the Color & Texture tab.

18 Click on the Face color chip.

19 Change the face color to H=162, L=84, S=40.

All of the text formatted with style 15 changes when you adjust the face 
color, but the rest of the text, including the text you highlighted, 
remains the same.

17 switch to the
Color & Texture tab

15

highlight the third
capital letter and 
click on style 15

12highlight the
first capital letter

14highlight the second
capital letter and 
click on Style 15

13 click on
Style 15

16
place your cursor

at the start of a
city name

18 click on the Face
color chip

19 change the 
face color
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Title Elements
You can change other title elements besides text. CG has features that make title elements easier to 
create and modify.

Backgrounds The Background tab contains all of the options you need to create 
backgrounds that use video, color, transparency, patterns, or images and 
textures.

You can create a video background by clicking on the Video button. You 
can create a black background by clicking on the Black button.

This procedure explains how to create a complex patterned background 
that uses an angled color gradient. See the online help for more 
background details if you need more information.

1 In CG, select the default template from the Templates drop-down list.

2 Switch to the Background tab.

3 Click on the color sample until the word TOP appears.

4 Change the top background color to H=0, L=52, S=99.

5 Click on the color sample until the word BOTTOM appears.

6 Change the bottom background color to H=225, L=52, S=99.

7 Select Blocks from the Pattern list.

You can see pattern names on the ToolTip for each pattern.

8 Change the Pattern size to 4.

1

4

select the
default template

switch to the
Background tab

change the
background

color

3
click on the

color sample

2
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9 Set the gradient angle to 30.

10 Change the Top transparency value to 75%.

11 Change the Bottom transparency value to 25%.

The color background is now semi-transparent, allowing some of the 
video background to show through, but the pattern elements are not 
video-transparent.

Screen Markers The View tab lets you display a number of useful options for aligning and 
placing text and graphic objects, such as tab stops, the video safe title area, 
screen centres, and baselines.

You can display each option by checking the checkbox beside the option. 
You can also modify the video safe title area and the tabs by clicking on the 
appropriate Edit button.

Layers Each CG title has 10 layers, and each layer is divided into a text plane and a 
graphics plane. See “Change Layers in CG” on page 4 for details.

7

select the
Blocks
pattern

8change the
pattern size

5click on the
color sample

6
change the
background
color

9 change the
gradient angle

11 change the
bottom
transparency

10

change the top
transparency
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Stills, Rolls, Crawls, and Animations
You can create four types of titles in TitleMotion: stills, rolls, crawls, and animations. Stills, rolls, and 
crawls can be created entirely in CG. Animations are created in CG and animated in FX.

Select a Title Type 1 Click on the Title Types drop-down list.

2 Click on a title type.

About Stills Stills are static screen images that contain text and graphic objects on top 
of a background. Some common types of stills are lower thirds, corner 
logos, and sports score titles.

About Rolls Rolls scroll text and graphic objects up or down on top of a static 
background, and are used for credits or other situations where you want 
text and graphic objects to scroll vertically.

any graphic objects
on a roll scroll with

the text

Rolls use a dotted white line to indicate page breaks. These lines don’t 
affect the way the roll is displayed, they simply divide the file visually to 
make it easier for you to work with. A scroll bar also appears so that you 
can scroll vertically to see your text.

If you place graphic objects on a roll, they scroll with the text. However, 
you can create a background for a roll that remains static as the text scrolls 
across it.

You cannot adjust the speed of a roll in TitleMotion. Any changes to the 
speed of a roll are made in your NLE.

About Crawls Crawls display a running line of horizontal text that scrolls from right to 
left, and usually contains information like warnings, weather reports, and 
call-in names.

Crawls are not limited to a single line of text. Text can be placed anywhere 
on the title and you can have as many lines of text crawling across the 
screen as you want. Crawls don’t use dotted lines to show page breaks, like 
rolls do. The text simply continues across the title and a scroll bar appears 
at the bottom of the CG Editor so that you can scroll horizontally to see 
your text.

1 2click on the
Title Types drop-down list

select a
title type
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any graphic objects
on a crawl scroll

with the text

If you place graphic objects on a crawl, they scroll with the text. However, 
you can create a background for a crawl that remains static as the text 
scrolls across it.

You cannot adjust the speed of a crawl in TitleMotion. Any changes to the 
speed of a crawl are made in your NLE.

Animations Animations let you change the way text and objects appear over time. You 
start with still text and graphic objects, and then use FX to decide how to 
change each object over time. You can change motion, color, movement, or 
transparency to fly text and graphic objects around in virtual 3D space. See 
“Animations and Keyframes” on page 54 for details on animations.

title backgrounds are
not visible in

animations unless
you check the Export

background setting
on the Animation
Settings tab in CG

All animations are based on CG titles. If you create a title and then click on 
the FX button, TitleMotion asks you if you want to convert the title to an 
animation. If you click on Yes, TitleMotion converts the title to an 
animation using the default animation settings and opens FX.

If you select Animation from the Title Types drop-down list, you can use 
the options on the Animation Settings tab to choose how to export the title 
text and the title background.

If you are using text in a box, text on a path, or text on a circle, remember 
that CG treats these kinds of text objects as graphic objects, and can only 
import them as single objects. The Export Text as Characters doesn’t affect 
these three types of text objects.

Export Text as Characters
makes each letter a
separate object in FX

Export Layer as Single Object
makes each layer a
separate object in FX

Export Text as Lines
makes each line a
separate object in FX
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Color
You can select colors in TitleMotion using one of three color models (HSV, HLS, RGB) or using the 
Color Picker. The Color Picker lets you select colors from any application that you can open in a 
Windows interface.

Use Color Models You can select colors using any of the three color models. This procedure 
uses the HLS color model, but the methods for selecting colors are similar 
in all three color models.

1 In CG, draw a rectangle using the Rectangle tool.

2 Switch to the Color & Texture tab.

3 Select HLS from the Color Model drop-down list.

4 Click on the Color Selector and drag it to a new location in the color 
selection box. 

When you drag the Color Selector, the L (luminance) and S 
(saturation) values all change, and the color in the Color Picker box 
also changes.

5 Click on the Color Slider and drag it up or down to a new location on 
the color slider bar.

When you drag the Color Slider, the H (hue) value changes, and the 
color in the Color Picker box also changes.

1 2

3

4

5

draw a rectangle switch to the
Color & Texture tab

select
HLS

click and drag the
Color Selector

click and
drag the 
Color Slider



TitleMotion 47

C
olor &

 O
bjects

6 Click on the L button.

The color slider bar now shows you the available luminance options, 
and the color selection box shows you the available hue and saturation 
options.

7 Click on the S button.

The color slider bar and the color selection box both change again.

The Color Picker The Color Picker lets you select any color visible on the screen.

1 Resize TitleMotion so that your Windows desktop is visible.

2 Click on the Color Picker and drag it across the visible Windows 
screen.

The color of the pixel under the tip of the Color Picker is visible in the 
Color Picker box, and changes as you move the Color Picker around 
the screen.

3 Release the mouse button to select the color under the pointer, which 
is shown in the Color Picker box.

6
click on
the L
button

7
click on
the S
button

3release the mouse
button to select the

color under the pointer

2 click and drag
the Color Picker
across the screen

1
resize
your
window
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Color Gradients
You can create two-color gradients with multiple repetitions for both text and graphic objects.

Create a Gradient This procedure describes how to create gradients for a text object, but 
creating gradients for graphic objects works exactly the same way.

1 In CG, select the default template from the Templates drop-down list.

2 Enter a line of text.

3 Switch to the Color & Texture tab.

4 Click on the Face color sample until the word TOP appears.

5 Change the top color to H=0, L=31, S=100.

6 Click on the Face color sample until the word BOTTOM appears.

7 Change the bottom color to H=0, L=100, S=0.

1

3

4

select the
default
template

switch to the
Color &

Texture tab

click on the Face
color sample

2enter text 5 change the
top color

6click on the Face
color sample

7change the
bottom color
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8 In the Gradient section of the tab, set the angle to 45.

If the gradient section is not visible on the tab, click on the cycle 
button to show the gradient options.

9 Set the Top value to 100% and the Bottom value to 0%.

10 Select Line from the Character/Line drop-down menu.

11 Set the Linear value to 3.

You can create radial gradients on characters by selecting Char from the 
Character/Line drop-down menu, and then clicking on the Linear button to 
switch to Radial.

8change the
Angle to 45

9

change the
Top and 

Bottom
numbers

11change the Linear
number to 3

10
select

Line
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Objects
You can create many different graphic objects using CG’s graphics tools. You can also add logos with 
alpha to CG titles and add textures to your text and graphic objects.

Graphic Objects The Formatting palette provides all of the tools you need to create any kind 
of graphic object in CG. The procedure below explains how to use one 
common graphic shape, but creating any graphic shape follows the same 
steps.

1 In CG, select the default template from the Templates drop-down list.

2 Click on the Horizontal Panel tool.

3 Draw a box in the title.

4 Switch to the Size & Attributes tab.

5 Change the Edge size to 17.

6 Change the Edge type to Tube.

7 Switch to the Color & Texture tab.

8 Click on the Face color chip.

9 Click on the Video button.

10 Drag your panel to the bottom of your title.

4switch to
the Size &

Attributes tab

1select the
default template

3 draw a box 2 click on the
Horizontal
Panel tool on
the Formatting
            palette

5 change the
edge size

change the
edge type

6
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Logos You can add logos to the Logo map and use them as graphic objects. The 
online help has a more complete discussion of logos and how to create 
them. This procedure explains how to add a logo to the Logo map.

1 Switch to the Logos tab.

2 Right-click on an empty slot.

3 Navigate to the graphic that you want to use as a logo and select it. 

You can preview graphics by clicking on the Preview window. Some 
sample logos are available in the Samples folder, located in your 
TitleMotion folder.

4 Click on Open.

switch to the
Color &
Texture tab

click on
the Video
button

7

8click on
the Face

color chip

9

10 drag your panel
to the bottom of
the title

3navigate to
a logo file

4click on
Open

2 right-click on
an empty slot

1 switch to the
Logos tab
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5 Click on the Logo tool.

6 Draw a box in the title.

7 Click on your imported logo on the Logos tab.

The logo appears on your layout as soon as you draw the box, but 
clicking on the Logos tab scales the logo and box on your layout so 
that it matches the aspect ratio of the original logo file.

Texture Mapping You can map textures onto text or graphics, in addition to using solid 
colors.

1 In CG, select the default template from the Templates drop-down list.

2 Click on the Rectangle tool.

3 Draw a box in the title.

4 Switch to the Color & Texture tab.

5 Click on the Texture sample.

6 draw a box

5 click on the
Logo tool

7 click on the
logo on the
Logos tab

3 draw a box

1select the
default template

2 click on the
Rectangle tool
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6 Click on the first empty slot on the Texture Map dialog.

7 Click on Define.

8 Navigate to where your texture graphic file is located and select it.

9 Click on Open.

10 Click on OK on the Texture Map dialog.

The tile and size
options beside the

Texture sample
determine if the

texture is tiled or
sized to fit the

object. The
alignment options

determine how the
texture is aligned to

the object.

11 Uncheck the Tint checkbox to see the texture without a color tint.

4switch to the
Color &

Texture tab

5click on
the Texture

sample

8 navigate to your texture graphic file

9 click on
Open

6
click on
the first
empty

slot

7

click on
Define

11

10 click on OK

uncheck the
Tint checkbox
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Animations and Keyframes
The animation section explains the basics of animations in FX, including templates and other 
features. The online help offers a complete explanation of all FX tabs and options, if you need more 
information than you find here.

Overview Keyframes identify each significant event in each animation path, such as 
the start and end points, a change in direction, or the start or end of an 
effect. Paths in FX are called splines. An animation in FX is the result of 
creating a number of keyframes and adjusting their splines.

You can add keyframes and build the animation manually, or you can apply 
a template and then tweak the template. Starting with a template is usually 
easier, unless you have an extremely precise animation that you need to 
build. See “Modify Animation Templates” on page 60 for details on using 
templates to build animations.

select Export
Background on the
Animation Settings
tab in CG to keep

the title background
with the animation

When you move a title from CG to FX, you can choose how to export each 
title object. Text can be exported as lines or individual characters, or you 
can export each layer as a single object. These settings are found on the 
Animation Settings tab in CG, and need to be set before you move the title 
to FX.

Markers on 
Splines

The spline follows the movement of the center point of your object. Splines 
consist of a line, frames, and keyframes. Each of the small square boxes on 
the spline represents a frame, unless you add too many frames to a spline 
for them to be shown individually. Each of the large, numbered boxes is a 
keyframe.

the spline
connects

keyframes and
shows the path

of the animation

unselected
keyframes
are displayed
using an
outline

keyframes are
identified by the
number in the
center of the
keyframe box

each box
on the path
represents a

frame
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FX Template Tips Templates in FX are a quick and easy way to add animation to a title. 
However, you should understand how the Templates tab works so that you 
can take advantage of all the available features.

You can select a template and then preview it on the Templates tab before 
applying it.

The buttons below the Templates list let you create and manage your 
animation templates. FX comes with a set of standard templates, but you 
can also create your own or download new ones from the Inscriber web site 
at www.inscriber.com.

if you don’t click
on Apply, changes

on the Templates
tab aren’t applied
to your animation

You need to click on the Apply button after you select a template and set 
the options for it, or the changes you make on the Templates tab are not 
applied to your animation.

you can choose
a template from

the Templates list

to see what the template
looks like when applied to
an object in your title,
use the Applied tab

to see what the template
looks like in its original

form, use the Template tab

switch between the Applied 
and Template tabs by clicking
on the tab name

click on the
Play button to
preview the
template on
the selected tab

add a new
template

update a
template

rename a
template

delete a
template

import a template from
another user or the
Inscriber web site

export a
template to
share with
other users
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Animate a Title
1 In CG, select Template 0 Default Template from the Templates drop-

down list.

2 Type the word “TitleMotion”.

3 Switch to FX.

Click on Yes when TitleMotion asks if you want to convert the current 
title to an animation.

you can still switch
between CG and
FX to modify the

appearance of text
or objects without

affecting your
animation settings

4 Select the first keyframe.

You can select keyframes by clicking on them or by selecting the object 
from the Object drop-down list and then entering the keyframe 
number in the Keyframe field. If you have many keyframes in an 
animation, you may find it easier to select keyframes using the list.

5 Press the INSERT key to add a second keyframe.

3
switch
to FX

1 select the default template

2

enter
some text

the FX Tool palette lets you
modify and position keyframes

the FX
Attributes

tabs let you
set options

numerically

select keyframes
with the Object
drop-down list

and the
Keyframes field

4

select
the first

keyframe
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6 Drag the second keyframe to a new position.

7 Click on Play to preview your animation.

8 Select the second keyframe.

9 Press the INSERT key to add a third keyframe.

10 Drag the third keyframe to a new position.

11 Click on Play to preview your animation.

12 Select the second keyframe.

13 Press the DELETE key to delete the second keyframe.

14 Click on Play to preview your animation.

Insert Home Page
Up

Delete End Page
Down

→

→

→ →

8select the
second keyframe

6drag the second
keyframe to a
new position

5press the Insert
key to add a

second keyframe

7click on the
green Play button

11click on Play
to preview the

animation

10

drag the third
keyframe to a
new position

12select the
second keyframe

Insert Home Page
Up

Delete End Page
Down

→

→

→ →

13

press the Delete
key to delete the
second keyframe

14
preview the

final animation9
press the Insert key to
add a third keyframe
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Use Animation Templates
Templates in FX are the easiest way to animate a title.

1 In CG, select Template 1118 Lower Third 18 from the Templates 
drop-down list.

2 Switch to FX.

Click on Yes when TitleMotion asks if you want to convert the current 
title to an animation.

3 Switch to the Templates tab.

4 Select Heading from the Object drop-down list.

5 Select Template 1 from left/to left from the FX Templates list.

6 Check the Reverse checkbox, and make sure Beginning is selected.

7 Click on Apply.

8 Select the second Heading keyframe.

9 Select Template 3 from bottom/to bottom from the FX Templates list.

10 Click on the Append radio button.

11 Uncheck the Reverse checkbox.

12 Click on the Templates tab Play button to preview the animation.

13 Click on the Absolute radio button.

If you apply a template absolutely, FX ignores the position of your 
current keyframes and moves them to the original keyframe positions 
of the template.

2
switch
to FX

1 select Template 1118

5select Template 1
from the FX Templates list

4select
Heading
from the

Object
drop-down

list

3switch to the
Templates tab

7click
on Apply

6 check the Reverse
checkbox, and select
Beginning
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If you apply a template relatively, FX maintains the position of the 
selected keyframe and applies the template relative to this starting 
position.

14 Click on the Templates tab Play button to preview the animation 
positioned absolutely.

15 Click on the Relative radio button.

16 Click on Apply.

17 Click on the Play button at the bottom of the FX Editor to preview your 
animation.

9select Template 3
from the FX Templates list

8select
the second

Heading
keyframe

11uncheck the
Reverse checkbox

12click on the
Play button 13click on

Absolute

10click on
Append

17

click on the
FX Editor 

Play button

14
click on

Play

16
click on

Apply

15
click on
Relative
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Modify Animation Templates
You can create, update, and export your own templates, use Inscriber templates, or import and export 
templates to share with other TitleMotion users. 

Create a Template You can create your own templates in FX.

1 In CG, select Template 1118 Lower Third 18 from the Templates 
drop-down list.

2 Switch to FX.

Click on Yes when TitleMotion asks if you want to convert the current 
title to an animation.

3 Switch to the Templates tab.

4 Select Heading from the Object drop-down list.

5 Select Template 1 from left/to left from the FX Templates list.

6 Check the Reverse checkbox, and make sure Beginning is selected.

7 Click on Apply.

8 Move the new Heading keyframe to a new position.

9 Switch to the Filter tab.

10 Change the Blur to 13 x 0.

11 Switch to the Templates tab.

2
switch
to FX

1 select Template 1118

5select Template 1
from the FX Templates list

4select
Heading
from the

Object
drop-down

list

3switch to the
Templates tab

7click
on Apply

6 check the Reverse
checkbox, and select
Beginning
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12 Click on the Add button.

13 Click on Yes to include only the selected path.

14 Enter a number and name for your template.

15 Click on OK.

Update a Template You can update a template by creating an original template or modifying an 
existing template, selecting the template name from the Templates list, and 
clicking on the Update button.

8

move
the new

keyframe
to another

position

9

switch to
the Filter tab

10

change the
Blur to 13x0

11

switch to the
Templates tab

12

click on
Add

13
click on Yes

15click on OK14enter a number
and a name



62 TitleMotion

A
ni

m
at

io
n

Template Options
You can select various options for your templates that determine how each template is applied to your 
existing animation. You can also exchange your templates with other FX users, or download templates 
from the Inscriber web site (www.inscriber.com), using the Import and Export options.

Overwrite vs 
Append

You can overwrite existing keyframes or append a new keyframe to the 
existing keyframes when you apply a template.

If you select Overwrite, any existing keyframes are deleted and the template 
is applied to the initial keyframe of the object.

If you select Append, a new keyframe is added to the end of the current 
spline using the settings of the template.

Relative vs 
Absolute

You can apply a template relatively or absolutely.

If you apply a template relatively, FX maintains the position of the selected 
keyframe and applies the template relative to this starting position.

If you apply a template absolutely, FX ignores the position of your current 
keyframes and moves them to the original keyframe positions of the 
template.

Beginning vs End You can apply a template to the beginning or end of a spline.

If you select Beginning, the template is applied before the first keyframe, 
regardless of which keyframe is selected.

If you select End, the template is applied after the last keyframe, regardless 
of which keyframe is selected.

The Reverse 
Checkbox

The Reverse checkbox applies the template in the opposite direction, and 
works in conjunction with the Beginning and End options.

To see what effect the Reverse checkbox has, use the Preview window on 
the Templates tab to preview a template using the various combinations of 
the Reverse checkbox and Beginning and End options.

Export a Template 1 In FX, select an animation template on the Templates tab.

2 Click on the Export button.

3 Navigate to the folder you want to save your template in.

4 Enter a name for the template.

5 Click on Save.

FX adds a .ifx extension to your filename. All FX templates have .ifx 
extensions.
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Import a Template 1 Click on the Import button.

2 Navigate to your saved template and select it.

3 Click on Open.

4 Enter a number and name for your imported template.

5 Click on OK.

1select a
template

2 click on
Export

3navigate to
a folder

4enter a filename

5click on Save

1click on
Import

3click on
Open

2select your
template

4

enter a name
and number for
your template

5 click on
OK
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Adjust Splines and Keyframes
You can adjust the position of a spline by changing the keyframe settings on the Attributes tabs. FX 
creates the splines automatically, based on the keyframe settings.

Use the Spline Tab You can use the Spline tab to change the shape of your spline. The online 
help provides even more information on using the Spline tab.

1 In CG, select Template 1118 Lower Third 18 from the Templates 
drop-down list.

2 Switch to FX.

Click on Yes when TitleMotion asks if you want to convert the current 
title to an animation.

3 Press the INSERT key.

4 Move the new keyframe to the top right corner of your title.

2
switch
to FX

1 select Template 1118

Insert Home Page
Up

Delete End Page
Down

→

→

→ →

3press
the

Insert
key

4move the keyframe
to the top right corner

5click on
Reverse Path

6switch to
the Spline

tab

7change the
Tension to 5.00

8click on
Play

9move the Ease
OUT slider
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you can reverse the
direction of a

spline with the
Reverse Path tool

5 Click on the Reverse Path tool.

6 Switch to the Spline tab.

7 Change the Tension to 5.00.

Tension, Continuity, and Bias all change the shape of your spline and 
the distribution of frames along the spline. You can use the Tension, 
Continuity, and Bias sliders to see what effect each option has on the 
selected keyframe’s spline.

If you have more than two keyframes on a spline, the effects of the 
Tension, Continuity, and Bias sliders are more apparent.

8 Click on the Play button to see how this change affects your animation.

9 Drag the Ease OUT of Keyframe slider back and forth.

As you drag the slider, the squares that represent frames move along 
your spline. You can use the Ease IN and Ease OUT sliders to control 
the way frames are spaced along the spline.

Copy and Paste 
Keyframes

You can copy and paste keyframes to transfer attributes from one object to 
another. When you copy and paste keyframes, you are not copying the 
object, just the FX attributes you have applied to that keyframe.

Copying a keyframe and pasting its attributes follows this general pattern:

• select a keyframe
• select Edit�Copy
• select another object from the Object drop-down list
• select Edit�Paste

When you paste the copied 
attributes, FX adds a new 
keyframe which has all of the 
attributes, including position, 
of the copied keyframe. You 
can decide where the new 
keyframe is added by selecting 
Edit�Insert/Paste Defaults 
and choosing an option.

You can copy the attributes of 
a keyframe to another existing 
keyframe by selecting 
Edit�Paste Attributes, instead of Edit�Paste. When you select 
Edit�Paste Attributes, FX does not add another keyframe to the end of the 
spline. Instead, it modifies the settings of the selected keyframe.
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Animation Timing Options
You can control the timing of each object’s motion path, including the positioning of each keyframe 
and the positioning of keyframes and splines relative to each other.

1 In CG, select Template 1803 Info Screen4 from the Templates 
drop-down list.

2 Switch to FX.

Click on Yes when TitleMotion asks if you want to convert the current 
title to an animation.

3 Select the Heading keyframe.

4 Press the INSERT key twice.

5 Move the new keyframes to new positions.

6 Click on the Reverse Path tool.

7 Switch to the Templates tab.

8 Select the Point 1 keyframe.

9 Select Template 1 from left/to left.

2
switch
to FX

1 select Template 1803

Insert Home Page
Up

Delete End Page
Down

→

→

→ →

6click on
Reverse Path

3select the
Heading

5move the
keyframes

8select the
Point 1

keyframe

4press the
Insert key

twice

7switch to the
Templates tab

9select
Template 1

10select Beginning
and Reverse

click on
Apply

1211change Count to 4
and Stagger to 31
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10 Select Beginning and Reverse on the Templates tab.

11 Change the Count to 4 and the Stagger to 31.

A Count of 4 automatically applies the template to the selected object, and 
to the next three objects in the Object list. You can rearrange the order of 
objects in CG by using the Bring to Front and Send to Back options.

The Stagger value spaces the four timelines evenly apart in time. The first 
timeline starts at 0 frames, the second timeline starts at 31 frames, the third 
timeline starts at 62 frames, and the fourth timeline starts at 93 frames.

12 Click on Apply.

13 Switch to the Time tab and scroll down until you see the Points timelines.

14 Click on Play.

15 Scroll to the Heading timeline.

move keyframes on
a spline by dragging
the diamonds on the

timeline

16 Click on the diamond in the middle of the Heading slider and drag it back 
and forth.

17 Drag the end of the Heading slider to the right.

You can shorten or lengthen the path of any object by adjusting its slider 
on the Time tab.

18 Click on the Play button.

13switch to the Time tab
and scroll down to

the Points timelines

14click on
Play

17drag the end of the
Heading timeline

16drag the diamond
back and forth

18click on Play

15scroll to the
Heading timeline
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Alpha and Selections
You can use Logo Compose to clean up logos and add alpha to them.

Select Areas of an 
Image

This section explains how to use the Lasso tool, but each selection tool 
works in the same way.

1 In Logo Compose, select File�Import/Export�Import image and 
import Samples\Vendor Sample Images\Aztec\1553_043.tif from your 
TitleMotion CD ROM.

2 Select the Lasso tool from the Tool palette.

3 Switch to the Select tab.

4 Use the Lasso tool to select only the leaf in the centre of the image.

The buttons on the Select tab determine how each selection is treated.

• single selection creates a new selection every time you draw a new 
outline

• add to selection adds the new selection to the current selection
• subtract from selection subtracts the new selection from the current 

selection
• intersect selection intersects any new selections with the current 

selection so only areas common to both remain selected
• move selection moves the selection to wherever you drag it

5 Use the Zoom tool to magnify the image so that you can do detail 
work more easily.

Click on an area of the image to zoom in on it. Hold down ALT and 
click on an area to zoom out.

3switch to
the Select tab

2
select the
Lasso tool

4

use the
selection buttons
to select the leaf

5

use the Zoom
tool to magnify

the image

1
import

the image
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Add Alpha You can add alpha to an image using the Logo Compose alpha tools. In 
Logo Compose, you can paint with alpha, fill with alpha, and create alpha 
gradients. This section explains how to add alpha to an image, and assumes 
that you have just finished the previous procedure.

1 Click on the Invert button on the Select tab.

2 Select the Add Alpha tool from the Tool palette.

3 Switch to the Brush tab.

4 Click on the largest soft-edged brush.

5 Click and drag anywhere on the image to begin adding alpha.

Because you are using a selection, Logo Compose only adds alpha to 
the area within the selection, so that the leaf is untouched, even if you 
drag the brush over the leaf.

You can also quickly fill the entire selection with alpha by selecting the 
Alpha Fill tool from the tool palette and clicking anywhere inside the 
selection.

2 select the Add
Alpha tool

3 switch to the
Brush tab

1
click on the
Invert button

4 click on the largest
soft-edged brush

5 click and drag
to add alpha
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Clean Up Logos
You can remove unwanted details from images, and use filters to modify the images.

Remove 
Unwanted Details

You can use Logo Compose to remove unwanted details from an image. The 
easiest way to remove these details is to replace them with other areas of the 
image using the Clone tool.

1 In Logo Compose, open Samples\Vendor Sample 
Images\Aztec\1553_043.tif on your TitleMotion CD ROM.

2 Select the Zoom tool from the Tool palette.

3 Click on a spot on the leaf two or three times to magnify it.

4 Select the Clone tool from the Tools palette.

5 Switch to the Brush tab.

6 Select the second soft-edged brush.

7 Hold down the ALT key and click on an area near the spot that you can 
use to replace the spot pixels with.

Make the best color match you can, and remember the grain of the leaf.

8 Move the pointer over the spot and click and drag to replace the spot 
with the selected area of the leaf.

You can see how the spot is going to look by placing the pointer over 
the spot. Logo Compose shows a preview of the brush stroke 
underneath the pointer, so you can make sure that your cloning blends 
before you apply it. You can change the selected area of the leaf at any 
time by holding down the ALT key and clicking on a new area.

5switch to the
Brush tab

7hold down
the ALT key

and click
on an area

to clone

6select the second
soft-edged brush

8click and
drag to

replace the
spot 

2 select
the Zoom
tool

4 select
the Clone
tool

1import
the image

3click on
the leaf to
magnify it
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Use Filters You can use filters to adjust, legalize, and clean up your images.

1 In Logo Compose, open Samples\Vendor Sample 
Images\Aztec\1553_043.tif on your TitleMotion CD ROM.

2 Switch to the Filter tab.

3 Select the Inscriber filters.

4 Select the Color Adjustment filters.

5 Select the Brightness & Contrast filter.

6 Click on the Select button.

7 Change the Brightness to 18 and the Contrast to 33.

8 Click on OK.

The online help describes each filter available in Logo Compose and 
explains what each of the settings does.

When you have finished modifying your image, you can add it to the 
Scrapbook so that you can use the image in CG. See “The Scrapbook and 
CG” on page 12 for details.

4 select the Color
Adjustment filters

1import
the image

2switch to
the Filter tab

3select the
Inscriber

filters

5 select the Brightness
and Contrast filter

6click on
Select

7
change the
Brightness
and
Contrast

8
click on
OK
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TitleMotion and Non-Linear Editors
Working with 
NLEs

TitleMotion acts as a plug-in for your NLE, and since each NLE works a 
little differently with TitleMotion, Inscriber has created a series of release 
notes that describe each NLE individually. These release notes are available 
on our website, at www.inscriber.com.

When you save a file in TitleMotion, it is dropped in a bin or otherwise 
located where your NLE expects to find CG files and animations.

If TitleMotion doesn’t plug directly into your NLE, or you are working in 
stand-alone mode, you can export titles and animations as a series of Targa 
files that your NLE can import and combine. 

You can also export an image or a sequence of images using the 
File�Export options. The online help explains how to use the export 
functions in detail.
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Boxed text ....................... 30

Deleting .........................33
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CG layers .....................4, 43
CG planes ........................43

Character map ................... 6
Characters ....................... 26
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Entering ........................ 26
Special ............................ 6
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Chips, style ...................... 20
Circle text ......................... 31
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Cloning in images ............ 70
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Adding .......................... 32
Deleting ........................ 32

Crawls ............................. 44
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Cycle buttons ..................... 5

D
Default template ............... 19

Updating ........................ 19
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Custom ......................... 29

E
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Edge over Face ................. 36
Edge, changing .................35
Embellished ..................... 36
Exporting titles .................. 9
Extended text styles ..... 36–41

Creating ........................ 36
Types ............................ 36

F
Face color chip ................... 5
Face, changing ................. 34
Field numbers, changing ..... 3
Filters ...............................71
Floating text ..................... 26

Moving .......................... 27
Fonts, selecting ................ 34
Frames, on splines ............ 54
FX ............................... 2, 54

Animations ..................... 45
Splines ..........................64
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Gradients .........................48

Color ......................48–49
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Radial ............................48
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in rolls ..........................44
Moving .......................... 50
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H
Help, online .......................2
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HSV ................................46
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Importing titles ..................9
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Keycodes ...........................7
Keyframes ........................ 54

Copying ......................... 65
Moving .......................... 67
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Layers .......................... 4, 43

Layer list ........................ 43
Layouts, in Scrapbook ........12
Linear gradients ................48
Loading titles .....................9
Logo Compose .............2, 68

Adding alpha .................. 69
and Scrapbook ................. 15
Backgrounds .................... 15
Cleaning up images ..........70
Cloning .........................70
Filters .............................71
Selections ......................68

Logo map .......................... 51
Logos ............................... 51

Adding to Logo Map ......... 51
Default template ...............16

M
Mapping textures .............. 52
Markers on screen ............ 43
Markers on splines ............ 54
Menus, right-click ...............7
Models, color ...................46
Motion template tips ......... 55
Motion templates ....... 58–67

Options ......................... 62
Updating ........................60

Mouse pointers ................28
Moving between layers ........4

N
Naming styles ................... 25
Naming templates ..............19
Neon ............................... 36
NLEs ...........................8, 72
Non tab-constrained. see

Floating text
Non-linear editors ........8, 72
Numbering styles .............. 25
Numbering templates .........19
Numbers, changing ............. 3

O
Objects. see Graphic objects
Online help ........................2
Opening titles ....................9
Overview ............................ 1
Overwrite .........................62

P
Path, for text .................... 32
Paths. see Splines ............. 54
Planes ..............................43

R
Radial gradients ............... 48
Recessed ..........................36
Relative ............................62
Removing styles ................ 25
Removing templates .......... 19
Renaming styles ................ 25
Renaming templates .......... 19
Resizing text ....................28
Reverse checkbox .............62
Reverse Path tool .............. 65
Re-wrapping text ..............28
RGB ................................46
Right-click menus .......... 7, 11

Scrapbook ....................... 11
Rolls ................................44

Graphic objects in ............44
Rotated text ......................28

Editing ...........................34
Rotating .........................28

S
Saving titles .......................9
Scrapbook ................... 10–15

Adding items .................. 12
and CG .......................... 12
and Clipboard ................. 14
and Logo Compose ............15
Backgrounds ....................15
Bitmaps ......................... 14
Deleting items ..................13
FX .................................15

Scrapbook continued
Overview .................... 2, 10
Right-click menus .............. 11
Selected items ................. 10
Style chips ..................... 20
Using items ................. 11, 13

Screen markers .................43
Shadow color chip ........ 5, 35
Shadow, changing ............. 35
Sheen ..............................36
Special characters .............. 6
Spellchecking ...................29
Splines ............................ 64

Frames ...........................54
Markers ..........................54

Stills ............................... 44
Style chips ....................... 20

in Scrapbook ................... 12
Style Library .....................22

Adding styles ................. 24
Closing ..........................22
Creating styles ................ 24
Deleting styles .................25
Loading styles ..................22
Opening .........................22
Renaming styles ...............25
Updating styles ................23
Using styles ....................22

Style names ......................25
Style numbers ...................25
Styles ....................20, 36–41

Deleting .........................25
Loading ..........................22
Renaming .......................25
Selecting ..................20, 22
Updating ........................23
Using ................20, 22, 38
Using Library ...................22

T
10 Edges ..........................36
Tab-constrained.

see Anchored text
Tabs ................................43
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Closing .......................... 16
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Opening ......................... 16
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Backgrounds .................. 42
Deleting ......................... 19
Loading .......................... 17
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Renaming ....................... 19
Selecting ................... 16, 17
Sorting ........................... 17
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Thumbnails ..................... 16
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Using ........................ 16, 17

Text ........................... 26–35
Aligning .........................43
Anchored ...................... 26
Baseline .........................43
Changing characters ... 38, 39
Changing layers ................ 4

Text continued
Default path ................... 32
Default style ................... 20
Default template .............. 16
Edge ..............................35
Editing rotated ................ 34
Entering ........................ 26
Extended styles .......... 36–41
Face ............................. 34
Floating ......................... 26
Formatting ..................... 34
in a box ....................30, 33
in a circle ...................31, 33
Markers ......................... 43
Mouse pointers ............... 28
Moving anchored ............. 27
Moving floating ............... 27
on a path .................. 32, 33
Resizing ........................ 28
Re-Wrapping .................. 28
Rotating ........................ 28
Special characters .............. 6
Tabs ............................. 43
Using styles .................... 38
Vertical ......................... 30

Text plane ..................26, 43
Text shadow, changing ......35
Texture Map .....................52
Texture sample .................52
Textures ...........................52

Using .............................52

Titles ...............................44
Animations ............... 44, 56
Backgrounds ................... 42
Crawls ...........................44
Creating ..........................8
Default title .....................19
Exporting .........................9
Horizontal center ............. 43
Importing .........................9
in Scrapbook ...................12
Opening ..........................9
Rolls .............................44
Saving .............................9
Spellchecking .................. 29
Stills .............................44
Templates .......................16
Vertical center ................. 43

V
Values, changing ................ 3
Vertical text ..................... 30
Video backgrounds ........... 42
Video safe title area .......... 43

W
Windows Clipboard ...........14
Workflow ............................1
Wrapping text ..................28
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Technical Support
You can get TitleMotion technical support from several places.

Technical Support 
from your dealer

Contact your dealer first. Since your dealer helped you configure your 
system, your dealer is also the best resource for system configuration 
issues and problems.

If your dealer 
can’t help you...

If your local dealer is unable to resolve your technical support problems, 
contact Inscriber Technology Corporation. 

Please have your software serial number available when you call Inscriber 
Technical Support. Your serial number can be found in a number of places, 
including software packaging, on the dongle, and on your TitleMotion CD 
ROM.

Phone: 1.519.570.9111 (9:00 a.m. – 5:00 p.m. EST)

Fax: 1.519.570.9140

Email: support@inscriber.com

You can also post a technical support question on our web site, and our 
support staff will answer your questions.

Product Updates You can download product updates from our web site, or you can use one 
of these methods to receive updates.

Fax: 1.519.570.9140

Web site: www.inscriber.com

Email: support@inscriber.com

Send Us Your Comments!
We would like your feedback on our documentation. If you have any 
comments or suggestions for us, please send us email at 
docs@inscriber.com. We can’t respond to these emails, but we will 
definitely use your comments in our next update.

Email: docs@inscriber.com


